Advantech WebAccess
- browser-based HMI and SCADA software
1. INTRODUCTION .................................................................................................................. 4
  1.1 WHAT IS WEBACCESS? ................................................................................................. 4
    1.1.1 Standalone PC ........................................................................................................ 10
    1.1.3 Client - System Requirements ............................................................................... 11
    1.1.4 Thin Client Requirements .................................................................................... 14
    1.1.5 Project Node and SCADA Node - System Requirements .................................... 15
  1.2 WHAT YOU NEED TO USE THIS QUICK START GUIDE ......................................... 17

2. CONNECT TO A WEBACCESS PROJECT ......................................................................... 20
  2.1 USE ORDINARY WEB BROWSER .............................................................................. 20
  2.2 START WEB BROWSER ............................................................................................. 20
    2.2.2 About Addresses .................................................................................................. 21
    2.2.3 WELCOME PAGE ................................................................................................. 22

3. WEBACCESS PROJECT MANAGER .................................................................................. 24
  3.1 LOGIN TO PROJECT MANAGER .................................................................................. 24
    3.1.1 Default Login - Name and Password .................................................................... 26
    3.2 QUICK TOUR OF CONFIGURATION MANAGER ....................................................... 26
      3.2.1 Select a Project and Node ................................................................................... 26
      3.2.2 Navigation Tree ................................................................................................ 29
      3.2.3 Add a Constant Point ......................................................................................... 30
    3.2.4 Download to remote SCADA node ...................................................................... 34
      3.2.5 Stop and Start a remote SCADA node ............................................................... 34

4. DOWNLOAD AND INSTALL WEBACCESS CLIENT PLUG-IN ........................................ 37
  4.1 SELECT A FEATURE THAT REQUIRES THE CLIENT PLUG-IN ................................ 38
  4.2 DOWNLOAD WEBACCESS CLIENT PLUG-IN .............................................................. 39
  4.3 RUN WEBACCESS SETUP.EXE .................................................................................. 42

5. VIEW REAL-TIME GRAPHICS - WEBACCESS VIEW .................................................... 53
  5.1 START WEBACCESS VIEW .......................................................................................... 53
    5.1.2 Default Login - Username and Password ............................................................ 57
    5.2 QUICK TOUR OF WEBACCESS VIEW ...................................................................... 60
      5.2.1 Navigation and Toolbars ..................................................................................... 60
      5.2.2 Toolbar ............................................................................................................... 62
      5.2.3 Dialog Boxes ...................................................................................................... 63
      5.2.4 Standard Displays ............................................................................................... 72

6. EXAMPLE A-GRAPHICS BUILDER-WEBACCESS DRAW ................................................ 79
6.1 START WEBACCESS DRAW .................................................. 79
6.2 DRAW TOOL BARS AND MENUS ........................................ 82
6.3 BUILD A SIMPLE GRAPHIC ................................................. 83
  6.3.1 Draw a Widget - Meter ................................................ 83
  6.3.2 Draw Text ............................................................. 86
  6.3.3 Dynamic Text Animation ............................................ 88
  6.3.4 Dynamic Pushbutton ................................................ 90
  6.3.5 SAVE Graphic .......................................................... 91
  6.3.6 Download Graphic .................................................... 93

7. EXAMPLE B - BUILD A PROJECT ........................................... 94
  7.1 START PROJECT MANAGER ............................................. 94
  7.2 CREATE A NEW PROJECT ............................................... 98
  7.3 ADD SCADA NODE ....................................................... 101
    7.3.1 Navigation Tree ................................................... 105
  7.4 ADD CALCULATION POINT ........................................... 106
  7.5 ADD ACCUMULATION POINT ......................................... 109

8. TIPS & TRICKS .................................................................. 111
  8.1 HOW TO START INTERNET EXPLORER? ............................... 111
  8.2 WHERE TO DOWNLOAD INTERNET EXPLORER? .................... 113
  8.3 ADDRESS BAR MISSING FROM INTERNET EXPLORER? .......... 114
  8.4 CANNOT INSTALL OR RUN CLIENT (VIEW OR DRAW) WITH USER ACCOUNT .................................................. 115
  8.5 SECURITY SETTINGS DO NOT ALLOW FILE DOWNLOAD .......... 116
    8.5.1 Add-Ons disabled in IE prevent Client from Starting ........ 117
  8.6 DETERMINE USER'S SECURITY PRIVILEGES .......................... 120
  8.7 LOCKED FILE DETECTED TRYING TO INSTALL CLIENT .......... 122
  8.8 BLANK SCREEN IN VIEW ................................................ 123
  8.9 HOW TO VIEW WITHOUT THE NAVIGATION TREE? .............. 132
  8.10 HOW TO OPEN WEBACCESS VIEW IN A NEW WINDOW? .......... 132
  8.11 HOW TO CONNECT DIRECTLY TO WEBACCESS VIEW? .......... 133
  8.12 WHAT IS A FIREWALL AND TCP PORT? .............................. 134
  8.13 DISABLE INTERNET CONNECTION FIREWALL IN XP .............. 135
  8.14 USE WEBACCESS WITHOUT AN INTERNET OR INTRANET ....... 136
  8.15 DETERMINE WINDOWS VERSION ..................................... 137
  8.16 HOW TO PING AND TEST YOUR TCP/IP CONNECTION? ......... 137
1. Introduction

1.1 What is WebAccess?

WebAccess is a fully web-based HMI and SCADA software package for industrial automation.

Using a standard Web-Browser, users can view and control automation equipment used in manufacturing facilities, industrial process plants and building automation systems. Additionally, all configuration and deployment can be performed through a standard web browser including IO configuration, graphics building, downloading, starting and stopping nodes remotely.

You also need a network connection. A dial-up modem will work fine. So will your company LAN or intranet if it allows a connection to a WebAccess SCADA node. Of course, the Internet gives you the flexibility to connect to any WebAccess SCADA node in the world, if you know its address and passwords. If you have an Internet connection you can connect to our Live Demo.  http://64.55.156.4/

Otherwise, use this guide to connect to the WebAccess node installed at your facility.

**Standard Web Browser**
**1.1.1.1 Microsoft Internet Explorer**

Internet Explorer 6.0, 7.0, or later is required to view real-time data through animated graphics and to build graphics (i.e. View and Draw). IE 6 and 7 support all features of WebAccess including remote project configuration and deployment.  

(See appendix, *Where to download Internet Explorer*).

The WebAccess **Project Manager** (i.e. database configuration) can be used with just a web browser: No software plug-in is required, No software installation on you PC.

**Older Browsers**

*If using IE 5.5 or older browser, you not be allowed to save to the database (because earlier versions do not execute the java script correctly). The older browsers may not display all data.*

WebAccess **VIEW** (Full Animation graphics) and **DRAW** (the graphics builder) require that you download an install a Plug-in (actually an ActiveX control).

**1.1.1.2 Graphics without the Plug-in**

You can view snapshots of graphics, without downloading the Plug-in by using our **Thin Client**.  If you are connecting with a PDA, you will automatically be redirected to the thin client address. The Thin Client interface for the demo is at  

http://64.55.156.4/broadweb/hd1/m.asp

**1.1.1.3 Can I use Netscape Navigator?**

You can use Navigator 6.1 to try-out or evaluate WebAccess, but we recommend you not use it for an actual project. If using Netscape, you will have to download the client from the "Download Plug-in Here"
link on the Welcome Page on the WebAccess project node. You will not find the WebAccess Plug-in at the official Netscape site.

**WebAccess Client**

The WebAccess Client is a "plug-in" that runs in conjunction with your Web Browser. The WebAccess Client enables your browser to act like a Human Machine Interface (HMI) that provides display of real time data with animated graphics, trends, alarms and reports. The WebAccess Client Plug-in is not needed for configuration. The WebAccess Client is needed to view real-time data (VIEW) and to build graphics using the graphics builder (DRAW). *If you try a WebAccess feature that requires the Client plug-in, WebAccess will prompt you and download the software to your PC.*

The WebAccess Client communicates to a SCADA node via a TCP/IP connection (internet or intranet).

**SCADA Node**

The SCADA node is a remote PC that physically connects and communicates with automation equipment. The WebAccess SCADA Node software provides Supervisory Control and Data Acquisition (SCADA) functions including:

- **Communication Drivers** (i.e. Modbus, OPC, and others) for Programmable Logic controllers (PLC), IO, Process Controllers, Automation Devices, Distributed Control Systems (DCS) and Direct Digital Control systems (DDC).
• **Data Logging** of real-time data for reports and trends.

• **Alarming** and **Alarm Logging**

• **Security** and **Event Logging**

The SCADA node does not need any Web Server software; for security, WebAccess handles communications between the Client and the SCADA Node through TCP/IP over two TCP ports. The SCADA node must be Windows 2000, Windows XP Professional, Server 2003, Server 2008, Vista Business or Vista Ultimate. There must be a TCP/IP service installed even if no network is used. There can be many SCADA nodes in a project accessed through a single WebAccess Project Node. For a single node project, the SCADA and the Project Node are often the same.

For a Standalone system (i.e. no network, no remote clients) a TCP/IP service is still required. It is recommended to install the LoopBack TCP/IP test service during Windows installation.

**ViewDAQ**

A local VIEW program called ViewDAQ is provided to enable operators to use the system in a stand-alone mode. ViewDAQ is available on the SCADA node only.

**Display Groups**

ViewDAQ also provide Display Groups allowing operators to save pre-arranged windows and call them at a later time with the
pre-specified display showing. An example of display groups is to open ViewDAQ 4 times, resize the windows as desired, one with and Alarm Summary, second with the main display and two small Faceplates. Saving this as a display group allows all four windows to be reopened with a single button click in the sizes and positions saved.

1.1.1.4 Redundant SCADA nodes

A Redundant SCADA node consists of primary and backup SCADA nodes, each with SCADA node software, license control file and Hardkey installed. The Project Manager will download an identical run-time database to both primary and backup SCADA nodes (assuming both are on-line). The Primary and backup will communicate with each other when the kernel is started, but only one will communicate to automation hardware. If the Primary fails, the Backup will begin communications to the automation devices. The Web Browser clients will be redirected to the backup if the primary node fails. The redundant SCADA node requires the purchase of two SCADA node licenses.

Project Node

The Project Node is a centralized database for all your SCADA nodes. A copy of all graphics and databases are stored on the Project Node and downloaded to the SCADA nodes. The Project Node provides the Project Manager functions for building I/O Databases, Alarms and Graphics. No plug-in is required to connect to the Project Node or Project Manager for database functions. The Client plug-in is required to use the graphics DRAW software. Usually, the Project Node is the same computer as the SCADA Node, but you can make them

The **Project Node is** also a **Web Server** and provides the initial connection between the Client and the SCADA node. The project Node runs Microsoft’s Internet Information Server (IIS) and is a Web Server. The **WWW Service (web Server)** must be installed. WebAccess supports Anonymous Access, Authenticated Access (Integrated Windows authentication), Secure Communications including Certificates, Secure Sockets, Virtual Private Networks (VPN) and secure intranets.

### 1.1.2 Standalone PC

If installed both **Project Node and SCADA Node** software on your PC or Laptop, you can use this QuickStart Guide to Build a project (there is a similar Guide in the Installation Manual).
For a complete description of Standalone and Network Architectures, please see the **Installation Guide** on the WebAccess CD or visit the Internet version of the Installation Guide at: [http://67.94.27.201/Manual/InstallGuide/InstallGuide.htm](http://67.94.27.201/Manual/InstallGuide/InstallGuide.htm)

### 1.1.3 Client - System Requirements


Windows Vista Home Basic, Vista Home Premium, are also supported as clients on many, but not all, hardware platforms  (See note 3.)

Microsoft Windows 98 and Windows XP Home support most, but not all, features in the WebAccess client.  (See note 2.)
**Hardware:** Pentium, Celeron, Athlon or better required by clients.

**Network Addressing:** Dynamic IP (DHCP) and fixed IP supported. Host names (e.g. computer network name), if recognized by client, SCADA Node and Project node, are also supported.

**Web Browser:** Microsoft Internet Explorer 6.0, 7.0 or later supports all features. ASP enabled and ActiveX enabled. A Medium Security Zone setting for safe browsing using either the Internet Zone, Intranet Zone or Trusted Site. Video Requires IE 6.0, 7.0, or later (ASP enabled).

**Display Resolution:** 1024 x 768 or higher (recommended). Lower resolutions also supported.

**Communications Service:** Microsoft TCP/IP Protocol.

**Communications Speed:** T1 or DSL is recommended. (33 Kb/sec, 56 Kb/sec, 128 Kb/sec and ADSL supported)

**User Security Privileges:** For Windows 98 / ME, all Users can install and run the Client.

For Windows Vista, 2000, 2003 and XP, Standard Users (i.e. a member of the Power Users) can install and run the client. Restricted Users (i.e. a member of Users) cannot install and cannot run the Client.

**Web Security:** WebAccess supports Anonymous Access, Authenticated Access (Integrated Windows authentication) and Secure
Communications including Certificates, Secure Sockets and Virtual Private Networks (VPN).

**Firewall Security (optional):** If using a connection through a Firewall, two additional TCP Ports assigned by your system administrator are required (4592 and 14592 are the default TCP ports). These are in addition to Port 80, the HTTP port, which must also be opened.

---

**Note 1 -** about Windows 2000, XP and 2003. WebAccess can be run under Windows 32 bit operating systems for Intel compatible systems only. It will not run under other types of Windows such as Windows for DEC Alpha or Windows for PowerPC®.

Windows XP requires service pack 2 (SP2) or later. 2003 Server requires service pack 1 (SP1) or later. Windows 2000 requires service pack 4 (SP4) or later.

---

**Note 2 -** Windows XP Home, Windows 98, and Windows ME do not support all advanced animation features in WebAccess including bitmap rotate and text rotate.

---

**Note 3 -** Windows Vista running on some hardware platforms (for example single core INTEL and AMD) do not support Video, Tools, Reports and web browser controls inside a graphic display.

It appears most Dual Core INTEL and AMD PCs produced after 2006 do support all features in the WebAccess Client using Vista.

It is recommended to test an Vista based PC before using it as a WebAccess Client if you plan to use Video, Tools, Reports, Logs or any Web control inside a graphic display.
1.1.4 Thin Client Requirements

Operating System: Microsoft Windows CE version 3.0 or later. Apple iPhone. Windows 95, 98, 2000, 2003, Vista and XP can be used.

Web Browser: Microsoft Internet Explorer (ASP enabled) for Windows CE and Windows. Safari for Apple iPhone.

Display Resolution: 200 x 200 minimum.

Communications Service: TCP/IP Protocol

Communications Speed: Wireless Ethernet, T1, DSL, ISDN, serial (33 Kb/sec, 56 Kb/sec, 128 Kb/sec) and ADSL supported

User Security Privileges:
No installation of software is required.


Note – The Thin Client interface supports static snapshots of graphics (GIFs and JPEGs). Each time the refresh button is pushed, a "snapshot" of the animation is made. Thin Client Displays do not update automatically. It does not support animation, pushbuttons, or drag regions (slider bars). Thin Clients require a continuous connection with the Project Node. Many thin clients will require an increase in the licensing requirements of the Windows 2000
Server and Server 2003. Windows 2000 and XP Professional are limited to 10 connections. Vista Business and Vista Ultimate software support an unlimited number of simultaneous connections to the server.

1.1.5 Project Node and SCADA Node - System Requirements


IIS (Internet Information Server) installed on the Project Node. The WWW Service (web Server) must be installed and running. ASP (Active Server Pages) enabled. The SCADA nodes do not need IIS.

SMTP Server (optional, not recommended). The SMTP service is not needed on the Project Node if using Email Alarm Notification, Email of Scheduled Reports or MAIL commands. WebAccess normally uses an external SMTP Server (for example the corporate email server or and ISP) to forward email. Optionally, you can allow the Project node to forward email directly.

NTFS File System - NTFS provides Security and it is faster. FAT provides no security and is not appropriate for the Web Server (Project Node).

Microsoft Licensing will limit the number of clients connecting to IIS. The Limit is 10 simultaneous connections in Windows 2000 and
XP Professional. In Windows 2000 and XP Server versions, the limit is dependant on your license (it can be unlimited). Vista Business is unlimited.

**Hardware:** Pentium III, Pentium IV, Celeron or Athlon processors are recommended for the Project Node and SCADA nodes. SCSI Hard Drive, SAN or other large cache storage recommended if Data Logging.

**Network Addressing:** Fixed IP Address or network address. See section [About Addresses](#) for more information.

**Web Browser:** Optional. Needed for configuration tool. Microsoft Internet Explorer 6.0, 7.0, or later. (ASP enabled) Medium Security Zone setting for safe browsing.

**Display Resolution:** (Optional although a Display is recommended). 1024 x 768 or higher (recommended). Lower resolutions also supported.

**Communications Service:** Microsoft TCP/IP Protocol.

**Communications Speed:** T1 or DSL is recommended. (33 Kb/sec, 56 Kb/sec, 128 Kb/sec and ADSL supported)

**User Security Privileges:**
For Windows 2000, 2003, XP and Vista, Standard Users (i.e. a member of the Power Users) can install and run the client. Restricted Users (i.e. a member of Users) cannot install and run the Client.
**Web Security**: WebAccess supports Anonymous Access, Authenticated Access (Integrated Windows authentication) and Secure Communications including Certificates, Secure Sockets and Virtual Private Networks (VPN).

**Firewall Security (optional)**: If using a connection through a Firewall, two additional TCP Ports assigned by your system administrator are required (the default are 4592 and 14592). These are in addition to Port 80, the HTTP port, which must also be opened (or a third port assigned for HTTP).

---

**Note 1 - about Windows 2000 and Windows XP**

Windows XP requires service pack 2 (SP2) or later.
2003 Server requires service pack 1 (SP1) or later.
Windows 2000 requires service pack 4 (SP4) or later.

---

**Note 2 - Windows Vista Home, Windows XP Home, Windows 98, and Windows ME are not supported as a Project node or SCADA node. They do not provide Web Server software. They can be Clients.**

---

### 1.2 What you need to use this Quick Start Guide

1. **A Web Browser.** We recommend **Internet Explorer 6.0 or 7.0**.

2. **An Internet or Intranet connection.** *If you do not have an Internet or Intranet connection see Tips & Tricks (Use WebAccess without an Internet or Intranet).*
3. Access to an existing **WebAccess Project Node** and SCADA node.

This Quick Start Guide assumes you have access to an existing WebAccess Project Node and SCADA node, either your own or our Live Demo.

**Internet to Live Demo**

If you have an Internet connection (without a firewall) you can connect to our demonstration WebAccess Project (the Live Demo). The WebAccess Live Demo is at [http://64.55.156.4/](http://64.55.156.4/)

**Internet through Firewall**

If you have an Internet connection, but it is through a firewall, see the Tips & Tricks section, [Live Demo TCP Ports](#). The WebAccess demo uses TCP ports 80, 4592 and 14592.

**Intranet**

If you are limited to an Intranet connection you must connect to a Project Node on your network. This guide assumes the project node is already installed. To connect to a newly installed WebAccess Project Node, you will need to get the IP Address, URL or computer name of your WebAccess Project Node from your system administrator.

**Standalone PC**

If both Project Node and SCADA node software is installed on your PC or Laptop, you can use this QuickStart Guide to build a project (there is a similar Guide in the Installation Manual).
If you are installing the WebAccess Project Node or SCADA node, please refer to the *Installation Guide* on the WebAccess CD or online at http://67.94.27.201/Manual/InstallGuide/InstallGuide.htm

Another good Reference is the Engineering Manual.

http://67.94.27.201/Manual/engman/engman.htm

This Quick Start guide does not cover installation of a SCADA node or a Project Node.

This Quick Start Guide shows you how to use the WebAccess Client in a standard Web Browser.
2. Connect to a WebAccess Project

2.1 Use Ordinary Web Browser

No special software required

There is no special software required to connect to the Project Manager. You do not need to install the WebAccess Client. All you need is a Web Browser, the address of your WebAccess Project Node and a Microsoft Operating System (Windows 98 or later). We recommend Internet Explorer 6.0, 7.0 or 8.0.

2.2 Start Web Browser

1. Start Internet Explorer.
   - Double Click the Icon on your Desktop
   - OR, Click Icon on your Taskbar
   - OR, From the Start button select: Start->Programs->Internet Explorer

   Tip - If you need more help, see Tips & Tricks, How to Start Internet Explorer?

2. Enter the IP address or URL into the "Address Bar" (see figure 1.1)
   For the Live Demo enter http://64.55.156.4/

3. Press the Enter key or Select Go.
Note - The address of the Live Demo might have changed since this guide was written.

See About Addresses for more information.

2.2.1 About Addresses

The first time you connect, you must enter the address of your WebAccess Project in the Address bar of your Web Browser. Later, you can add this address to your "Favorites". The address can take several forms:

- **URL** is the Universal Resource Locator, for example http://www.advantech.com/. If your company has assigned a URL to your WebAccess Project, enter this in the Address Bar of Internet Explorer.

- **IP Address**, Internet Protocol Address. The IP address is a series of 4 numbers separated by periods (e.g. http://64.55.156.4).

- **Computer Name** - If you are on an Intranet, you can enter the computer name of the WebAccess Project Node (for example
Quick Start

"Server1"). This can be either a TCP/IP "host name" or the Microsoft Network name.

- **Local PC** – If you are on a PC that has the Project Node software installed and a network card, you can use the default localhost address or url:
  
  http://localhost or http://127.0.0.1

  If you are on a standalone PC without a network card, and you have the Project Node software installed, you must use the computer name: 
  (for example http://YourPCName).

### 2.2.2 WELCOME PAGE

**Congratulations!** You have successfully connected to a WebAccess Project. It took no special software to connect. No software download was required.

There are two choices on the Welcome Page (bwroot.asp).

- Project Management

- Realtime Monitoring (also called View)
Let’s next go to Project Management, which does not require additional software and can be used **Internet Explorer** Browsers.

If you are in a hurry to see Real-time Graphics, jump ahead to **Step 3 – Download and Install WebAccess Client Plug-in**.

Other wise, continue to **Step 2 – WebAccess Project Manager**.
3. WebAccess Project Manager

3.1 Login to Project Manager

So to start, let's begin with a quick tour of the Project Manager. We assume you have just Connected to WebAccess *(for help, go back to Step 1 - Connect to a WebAccess Project).*
1. Select "Project Management" button on the WELCOME PAGE, figure 1.2, (bwroot.asp).

2. Configuration Login Page appears, figure 2.1 (bwconfig.asp)

If this is a new system or you are connecting to the Live Demo, use the "Default Login". Otherwise, use your Login Name and Password.
3.1.1 Default Login - Name and Password

1. In the Login Name field type: admin

2. Leave Password field blank (i.e. no password).

3. Click the Login Button.

4. "WebAccess Project" list appears, figure 2.3 (bwproj.asp)

3.2 Quick Tour of Configuration Manager

This section assumes you have access to an existing Web Access Project Node with a project already configured. If you do not have access to an existing WebAccess project, jump to Example B - Build a Project.

3.2.1 Select a Project and Node

Select your project listed under Project Name from the WebAccess Project Page, figure 2.3 (bwproj.asp).
1. For Demo select **LiveDemo**

   *If there is not a project listed, you can create one. Go to the [Example B - Build a Project](#).*

2. "Project Manager" appears, figure 2.4
3.2.1.1 Select Node

3. Select a Node from the navigation frame on the left under "Project/Node", figure 2.5. For Example, select SCADAnode1.

If there is not a project listed, you can create one. Go to the Example B - Build a Project.

4. SCADA Node properties appears, figure 2.4
3.2.2 Navigation Tree

Web Access Navigation Tree (Figure 2.7) is in the left frame of the Project Manager (see Figure 2.6). It shows Project(s), Node(s), Device Type, OPC Items etc.
3.2.3 Add a Constant Point

Let’s create a Constant Point Tag. As an example, this guide uses the LiveDemo. If someone has already created the tag, use a different name for your constant point tag.

1. Select Const Point from the navigation frame on the left under "Project/Node", figure 2.8.
or Select ConstPoint from SCADA Node properties.

2. A list of Constant Points appears in the main frame (figure 2.9a).
3. Select **Add Constant Point** from the main frame.

4. The "Create New Tag (Constant)" Page appears (Figure 2.9b)
Figure 2.9b - CONSTANT Point configuration

5. Type a **Tag Name**. For example, type **SPEED**

6. Scroll down and change any other fields you desire.

7. Press **Submit** button.

**Congratulations!** You just created a constant point Tag. You must download and restart the SCADA node for the point to become active.
3.2.4 Download to remote SCADA node

This will download the database configuration with the new tag(s) to the SCADA node. If the node is running, the download will temporarily stop the SCADA node, then restart the node after the download.

1. Select a **Node** from the navigation frame on the left under "Project/Node", figure 2.5.

   For example, in the LiveDemo, select **SCADA node1**

2. SCADA Node properties appears, **figure 2.6**

3. Select **Download** from the main frame (**figure 2.6**). **Download**

4. A Popup window appears showing status of the download.

5. Close the Popup window when **DONE** appears.

3.2.5 Stop and Start a remote SCADA node

"STOP Node" stops data collection and real-time communications between the SCADA node and field devices. Trending Stops, Displays are not updated. START resumes normal communications.

1. If you have not done so, select a Node from the navigation frame on the left under "Project/Node", **figure 2.6**.

   For example, in the LiveDemo
Select **SCADAnode1**

2. Select **Stop node** from the main frame. (Figure 2.6)

3. A Popup window appears showing status of the node.

4. Close the Popup window when **DONE** appears.

5. Select **Start node** from the main frame. (Figure 2.6)

6. A Popup window appears showing status of Start.

7. Close the Popup window when **DONE** appears.

Remember that if you use the **STOP Node** feature, **be sure to use the START node feature before continuing**.

**Project Manager without any additional software**

Using an ordinary web browser and without downloading or installing the Client Plug-in, you can use any feature in WebAccess, except two: Start View and Start Draw.

If you want a guided example of creating a project or creating points and tags, go to the Example B - Build a Project.

For now, click any item in project manager and explore. **Just remember that if you use the STOP Node feature, be sure to use the START node feature before continuing.**
If you click on a feature that requires the WebAccess Client Plug-in (Start View or Start Draw), WebAccess will prompt you to download the Client software. If you do not want to download, hit the back button.

If you do want to download and Install the Client-Plug-in, go to the next section.
4. Download and Install WebAccess Client Plug-in

Overview

WebAccess prompts you to download the Client Plug-in.

If you select a WebAccess feature that requires the Client Plug-in, and it is not yet installed, WebAccess will prompt you to download the client.

Microsoft Internet Explorer 6.0 or 7.0 recommended

Microsoft Internet Explorer 6.0 (or later) is needed run the Client Plug-in.

Windows 2000, Server 2003, Server 2008, Vista and XP users must be Standard Users (also called Power Users) to Install and Run the Client

If you are using Windows 2000, Sever 2003, Server2008 Vista or XP, you must be a Standard User to install and run the WebAccess Client. A Standard User is a member of the Power Users.

Restricted Users (i.e. members of the Users Group) cannot install and cannot run the WebAccess Client. You should contact your system administrator and ask to be changed to a Standard User (i.e. A Power

Windows 98 - all Users can Install and Run the Client

If you are using Windows 98 or ME you can run and install the WebAccess Client. There is no restriction for you.

4.1 Select a feature that requires the Client Plug-in

There are two features in WebAccess that require the "Plug-in":

1. DRAW

2. VIEW

If you do not already have the Client Plug-in installed (or there is a version mismatch), you will be prompted to download and install it if you select either VIEW or DRAW.

There are four ways to get the Prompt to Download the Client:

- Select the Realtime Monitoring button to start View from the Welcome Page (figure 1.2).

- Select the "Download Plug-in Here" from the Welcome Page (figure 1.2).
• Select the Start View link in the Project Manager, SCADA Node properties (figure 2.6).

• Select the Start Draw link in the Project Manager, SCADA Node properties (figure 2.6).

**Note** - the Client Plug-in contains an Active-X control for use with Internet Explorer (6.0 or 7.0) plus a Help file.

### 4.2 Download WebAccess Client Plug-in

If you can run Internet Explorer 6.0 or 7.0, chances are you can use the WebAccess Client, which is a Active-X plug-in to IE 6.0 and 7.0. Please refer to **Client System Requirements** for more information.

1. The prompt to Download and Install Client appears. (Figure 3.3) if Client not already installed.

**Figure 2.3 - Prompt to download and install WebAccess Client**
2. Click on "Please click here to install WebAccess Client" (figure 2.3).

3. Windows File Security Dialog Box appears (figure 2.4).

![Windows File Security Warning Download dialog box](image)

**Figure 2.4** - Windows File Security Warning Download dialog box

4. Select **Save** (figure 2.4) to save WebAccessClientSetup.exe to disk.

5. The Windows Save As Dialog Box appears (figure 2.5)

We recommend that you save to Disk unless you have a very fast Internet Connection. We also recommend that you save to Desktop, so that you can find the WebAccessClientSetup.exe program easily in order to run Install.
6. Select the Desktop as location to Save the Setup file.

7. Select Save button (figure 2.5).

8. Download Dialog Box Appears (figure 2.6)
How long it takes to download the Client Plug-in depends on your Internet connection. The file is approximately 4 Megabytes.

9. Select the Close button to close the Download Dialog Box, if it did not close automatically (figure 2.6).

**Tip - If you select Open, it will start the WebAccessClientSetup.exe (the same as step 1 of Run WebAccess Setup)**

### 4.3 Run WebAccess Setup.exe

1. Close Internet Explorer, if it is still running. You are also advised to close any programs and save any work you have in progress.

2. Double Click the WebAccess Setup.exe icon on your Desktop.
3. The "Open File Security Warning" appears (figure 2.6) if you have user privileges to install software. Select **Run**.

![Open File Security Warning]

*Figure 2.6B - Open File Security - select Run.*

*Windows 98  – All Users can Install and Run Client*

*Windows 2000, Vista, XP, 2003, 2008 – Must be a Power User to Install and Run Client*
If you are using Windows 2000, Server 2003, Vista or XP, and you see the Dialog Box in figure 2.7, you do not have the security privileges required to install software. Contact your system Administrator or logout, then log in as either a Power User or Administrator.

For more information about Security required to Install and Run the Client see Troubleshooting Section: [Determine User’s Security Privileges](#)

4. The Install Shield will run automatically (unless you hit cancel).
4. The dialog boxes shown in Figure 2.8a and 2.8b may appear and disappear very quickly if you have a fast PC.
Figure 2.8b - Starting Install Shield Wizard

Figure 2.9 - Welcome to the InstallShield

5. Welcome to Setup: Select Next.
6. **License Agreement**: Select **Yes**.
Figure 2.10 - Customer Information

7. Customer Information:
   Enter User Name and Company and select Next >.
Figure 2.11 - Destination Folder to install WebAccess Client

8. **Destination Folder**: Select *Next >*

   We recommend you accept the default folder to install WebAccess. *Drive:*\WebAccess\Client. For example C:\WebAccess\Client

9. **Client Plug-in software installs to the Destination Folder.**
10. The Setup adjusts security settings of the Client Folder.

If you get the Locked File error, please see Locked File Detected trying to Install Client in the Appendix.

11. Finish - Restart Your Computer sometimes required.
Sometimes, you must restart your computer. The reason you would be required to restart your computer is if a DLL or other program object was in use by another program that needed to be replaced by WebAccess; this sometimes happens with older versions of Windows (e.g. 98, 2000) or older service packs. If all items are copied without a conflict with another program, then you will not be prompted you to restart and you don’t have to restart.
Figure 2.12 - Restart Your computer?

If you are prompted to restart your computer, and you know your password to logon to your computer, select "Yes, I want to restart my computer now."

11. Select **Finish**.

12. Restart Internet Explorer and start **WebAccess VIEW**.

For information about installing **Project Node** software or **SCADA Node** software installation, please refer to the Installation Guide on the WebAccess CD or on the web at [http://67.94.27.201/Manual/InstallGuide/InstallGuide.htm](http://67.94.27.201/Manual/InstallGuide/InstallGuide.htm)
5. View Real-time Graphics - WebAccess View

Overview

To view real-time data and animated graphics, you need to install the Client Plug-in. Refer to the previous section if you have not already installed the WebAccess Client Plug-in for Internet Explorer.

5.1 Start WebAccess View

1. Start Internet Explorer.

2. Enter IP Address of a WebAccess Project Node in Address Bar or select from "Favorites". (For help see, 1.2 – Enter IP Address or URL in Web Browser).
5.1.1.1 Select WebAccess View

3. Select the **Realtime Monitoring** button to start View.

4. If there is more than one Project or SCADA node, a Project Tree appears (Figure 4.2). Please select a SCADA node from the **Project Tree** in the left frame in Figure 4.2. For example, select SCADA node1.
If there is only one SCADA node, then VIEW opens without a tree (figure 4.3).

The WebAccess View Login Page appears if the SCADA node is running.

If you get the message "Waiting for Connection", the node is probably stopped. You can pick "Start Node" from the navigation frame on the left or at the top of the page or go back to project manager and Start the node (section 2.2.3 Start and Stop SCADA node). You might be asked to login to Start the node: The default User Name is "admin" and there is no password.
If you see the message "Waiting for Connection to SCADA node" or "Connecting to Server" for more than a minute, but connection to the Welcome Page worked (figure 4.1), then a **firewall** is the most likely reason. Please see [What is a Firewall and TCP Port?](#) for more information on firewalls.

**Hint** – Notice that Figure 4.3 does not show the Navigation Tree in the left frame. It was opened using the "Open in New Window" feature. To find out [How to View without the navigation tree?](#), go to the Tips & Tricks section.
5.1.2 Default Login - Username and Password

1. The Login in display appears. Yours may look different.

2. Click anywhere with the mouse on the center of the WebAccess display and the Login Dialog Box appears (figure 4.4).
3. Enter "User Name".

   Note that you can use either your keyboard or the mouse in the Login dialog box.

4. Enter "Password".

   The default login is,

   User Name: admin

   Password: (i.e. a blank password)

   Tip - if this is a newly installed system, use the default login.
5. Press the **Enter** key. WebAccess Welcome Display appears (figure 4.5).

![WebAccess Welcome Display](image)

*Figure 4.5 - Main.bgr - the default Welcome page in VIEW.*

(Note— the main display can be modified and yours may look different).
Congratulations! You are connected via the Internet to the first fully web-base HMI and SCADA system.

5.2 Quick Tour of WebAccess View

There are multiple ways to navigate between displays in WebAccess:

1. Toolbar at the top of each page
2. Right Click Popup Menu in VIEW
   a. (Replaced by the Menu bar in ViewDAQ)
3. Pushbuttons on displays.

5.2.1 Navigation and Toolbars

There are pre-built navigation systems in WebAccess including:

1. The "Right Click" popup menu in web-browser VIEW
2. Toolbars.
3. Goto in the Point Info Dialog Box.
4. Pushbuttons built into displays.

5.2.1.1 "Right Click" Popup Menu

1. Right Click the mouse inside the WebAccess Browser window.

3. Drag the mouse down the Navigation Popup Menu to **Goto**. (See figure 4.7).

![Figure 4.7 - "Right Click" Popup Menu - GOTO menu selected](image)

On any display, you can “Right Click” the Mouse and get a Navigation Popup Menu.
Selecting GOTO also shows a list of all Standard Function Keys on the Keyboard (for example F5 will call up the alarm summary).

5.2.2 Toolbar

![Figure 4.8 - standard Toolbar for graphic display](image)

The Toolbar is a row of pushbuttons at the top of each graphic display window. The toolbar is used to call new displays, acknowledge alarms and open dialog boxes. Engineers can customize the appearance of the toolbar, by adding or deleting buttons and icons. The toolbar can change based on the display being viewed. Users can hide the toolbar using View Property link. Engineers can hide the toolbar by using the bwviewpg.asp options.

The Status Bar at the bottom of the display shows the description of each button on the Toolbar by moving the cursor over that button.
5.2.3 Dialog Boxes

WebAccess provides many standard pop-up style dialog boxes for navigation and diagnostics.

- **Graph List** – a menu of user built displays
- **Point Info** – a menu of all Points and Tags
• Change dialog box - To view and change Analog values
• Change dialog box - To view and change digital or integer values
• Change dialog box - To view and change Text
• Point GOTO - shows all displays for a selected point or Tag
• Recipe List - a menu of user built recipes
• Real Time Trend List
• Data Log Trend List
• Video

5.2.3.1 Graph List Dialog Box

Graph is an abbreviation for Graphic Display

1. Call up the Graphic List by one of three methods:

   • Select icon on the Toolbar (see section 4.2.2 Toolbar).

   OR

   • Press F9 on your keyboard

   OR
• Use the **Navigation Popup Menu.**

Right Click → Goto → Graph.

2. The **Graph List Dialog Box** pops up (figure 4.9).

![Graph List Dialog Box](image)

*Figure 4.9 - Graph List Dialog Box*

3. **Double click** on the **Graphic name** (figure 4.9)

   OR

Single click on the Graphic name and press OK.

For example, **double click** on **Meter.bgr**
4. The graphic display you selected appears. (Figure 4.10 shows an example from the LiveDemo)

Figure 4.10 - User Built Graphic Display from Live Demo - GrainAuto.bgr

5.2.3.2 Point Info

The Point Info Dialog Box is a menu of all Points and Tags plus information about them, including current value, alarms, Displays they appear on. The Point Info Dialog box also has the ability to change the value of any tag.
1. Call up the Point Info by one of three methods:

   ● Select the icon from toolbar (see section 4.2.2 Toolbar)
   OR

   ● Use the Navigation Popup Menu:

     Right Click → Goto → Point Info

   OR

   ● Press CTRL-F5 on your keyboard

2. The Point Info Dialog Box appears (figure 4.11).

3. Select a point or Tag from the list on the left of the dialog box. (e.g. pick SPEED figure 4.11)
5.2.3.3 Change dialog box - Analog

1. There are two methods to get the Change Dialog Box.

   - Select the **Change button** in the Point Info Dialog Box (figure 4.11).

OR

   - Double click on any pick-able dynamic number on a user built graphic (figure 4.10).
2. The Analog Change Dialog Box appears (figure 4.12).

3. Click the Ramp Arrows to change a value.

4. Click the **number keys** in the Change Dialog Box (figure 4.12) to enter a value.

For example, ENTER 60

5. Click **Enter** to close the Change Dialog Box (figure 4.12).

6. Click **Exit** to close the Point Info Dialog Box (figure 4.12).
Click **Hold Output** to keep the dialog box open while making a change instantly effective.

You can use both the keyboard or mouse to enter values.

**5.2.3.4 Point GOTO - shows all displays for a Point or Tag**

1. **Single Click** any "pick-able" point on a graphic (the tag named SPEED is already selected if you are following this step by step).

2. **Right Click the mouse** inside the WebAccess Browser window.

3. The **Navigation Popup Menu** appears.
4. Drag the mouse to **GOTO**.

5. Drag the mouse to **Point Goto**.  (Figure 4.13)

The "Point Goto" Popup Menu shows all the displays using the selected point.

For example, Figure 4.12 above shows displays that use the tag named SPEED from the Live Demo. SPEED shows up on:

- The a Real Time Trend (trend # 1),
Quick Start

- An X-Y Plot (Plot #1),
- A Graphic named Meter (Meter.bgr),
- And a Point Detail Display.

5.2.4 Standard Displays

WebAccess automatically generates displays, called standard displays including:

- Alarm Summary
- Real Time Trends
- Data Log Trends
- Block Detail
- Point Detail
- Station Status
- Alarm Log
- Action Log

Users can customize these displays using the graphics builder (DRAW). Let’s take a quick tour of the standard Alarm Summary, Alarm Log, Point Detail and a Real-time Trend.
5.2.4.1 Alarm Summary - F5

The Alarm Summary shows all current alarms and all unacknowledged alarms.

![Image of Alarm Summary]

*Figure 4.13 - Alarm Summary showing Unacknowledged in Red and Acknowledged Alarms in black.*

There are three ways to View the Alarm Summary:
- Use the Navigation Popup Menu:

  Right Click -> Goto -> Alarm Summary

OR

- Select from toolbar (see section 3.3 Toolbar)

OR

- Press F5 on your keyboard

5.2.4.2 Alarm Log - Ctrl F8

The Alarm Log is a history of all alarms and when they were acknowledged.
There are three ways to view the Alarm Log:

- **Right Click → Goto → Alarm Log** (see figure 4.14)

OR

- **Select the icon from toolbar** (section 3.3 Toolbar)

OR

- **Press CTRL and F8 keys simultaneously on your keyboard.**
5.2.4.3 Point Detail

The Point Detail shows "drill down" information about a Tag or Point.

![Point Detail Display](image)

**Figure 4.15 - POINT DETAIL DISPLAY**

To view a Point Detail, use the Navigation Popup Menu (see figure 4.7)

Right Click -> Goto -> Point Goto -> Point Detail
5.2.4.4 Real-time Trend - F3

WebAccess automatically generates a real time trend display for each Trend Group configured in the Database Configuration. At least one trend group has to be configured for you to see a trend Display. The User can Add Tags "On-the-Fly" by using the New Tag Button.

Figure 4.16 - REAL TIME TREND

To view a real-time trend display
1. **Right Click** → **Goto** → **Realtime Trend** (see *figure 4.7*)

    OR

    Select the icon from toolbar (figure 4.9)

2. Select a trend from the **Realtime Trend List** Dialog Box (figure 4.17).

*Figure 4.17 - Realtime Trend LIST dialog Box*

6.1 Start WebAccess Draw

1. Start Internet Explorer 6.0 or 7.0

2. Enter Address of a WebAccess Project Node in Address Bar or select from "Favorites". 
   (For help, see Step 1).

3. Login to the Project Manager (bwconfig.asp). (For help, see Step 2).

4. Select a Project, for example LiveDEMO (see 2.2.1).

5. Select a Node; for example, select SCADAnodel.

6. Right Click the Start Draw link in the Project Manager. 
   (Figure A.1)

7. Select Open in New Window or Open in New Tab from the menu (figure A.1).
If you **click** on **Start Draw**, the Draw program will open in the lower right frame of the WebAccess Project Manager.

If you **Right Click** on **Start Draw**, a menu appears allowing you to open Draw in a new browser window, full screen (**Open in a New Tab** or **Open in New Window**) see figure A.1.
Figure A.2 - Start WebAccess DRAW - graphics builder in new window
6.2 Draw Tool bars and Menus

6.2.1.1 Toolbar - Top
Tool tips (text in a yellow box) appears when the mouse is moved over a toolbar icon.

**6.2.1.2 Toolbar - Bottom**

![Toolbar - Bottom](image)

**6.2.1.3 Popup Menus**

Right Click the Mouse to get Popup Menu of Drawing tools (see figure A.2). These are the same tools as found on the toolbars. The popup menus are just another method of accessing drawing tools quickly.

![Figure A.3 - Draw Menu](image)

### 6.3 Build a simple Graphic

#### 6.3.1 Draw a Widget - Meter

1. Click the **Widget icon** from the Draw Toolbar (see A.2).

2. Select $\text{meter01}$ from the Widget File List (figure A.4).
3. Select **OK**.

4. The **TAG LIST** appears (figure A.5).

5. Select the **DaqTag button** to view all system tags (figure A.5). This list is always full of tags.
6. Select the I/O Tag button to view all tags built by the user (figure A.5). This list may be empty if there are no user-built tags.

7. Select a TAG from the List (for example, SINE).

8. Select OK.

9. Position the Widget with the Crosshair. An outline of the widget is superimposed on Crosshair (figure A.6).

10. Click once to Draw Widget (figure A.7).
Congratulations! You have just drawn and animated a meter that will indicate the value of your tag. The needle will move as the value changes. The High Scale and Low Scale of the Tag will be displayed.

6.3.2 Draw Text

1. **Click** the Text icon from the lower Draw Toolbar (see A.2).

2. Position the Text Starting Point with the Crosshair.

3. **Click once** to fix the Text Start Position.

4. **Type** in your text using your keyboard. (For example, type "SETPOINT").

5. Press **ENTER** when done

6. Reposition the Text. **Hold the left mouse button down** over the text, while moving the mouse.
7. Draw Text to act as placeholder. (Repeat Steps 1 to 6). Type six characters. For example type "XXXXXX".

8. To select both Text fields (i.e. SETPOINT and XXXXXX). **Hold the left mouse button down** and **drag a rectangle** that covers both text fields.

9. **Right Click** -> **Edit** -> **Align**.

10. Select **Align Center** from Dialog Box (figure A.8).

![Alignment Dialog Box]

Figure A.8 - Align Dialog Box
6.3.3 Dynamic Text Animation

1. To animate text with real-time data:

   Right Click → Dynamic → Animation

   OR

   Select the Dynamic icon from the upper toolbar (see A.2).

2. Animation Dialog Box appears (figure A.10).

4. Select a **TAG** from the List (for example select SPEED).

5. Select **OK**.

6. **Click once** on the XXXXXX text. (See Figure A.9)

7. A red box should appear around the XXXXXX signifying that the text is Dynamic. (See figure A.12)
6.3.4 Dynamic Pushbutton

Draw Text, for example "ALARM SUMMARY". (See DRAW Text example above to refresh your memory).

1. Right Click → Dynamic → Pushbutton.

2. Pushbutton Dialog Box appears (figure A.11)

3. Select Macro button (figure A.11)

4. Drag slider bar to move down the list of Macros to find <GOTO ALMSUMMARY>

5. Double Click on <GOTO ALMSUMMARY>.
6. Check **GROUP Objects**.

7. Select **OK**.

8. **Click Once** on the Text drawing in step 1 (for example **ALARM SUMMARY**) (see figure A.12)

9. **Right Click Once**.

![Figure A.12 - Widget, Text, Dynamic Text and Pushbutton](image)

**6.3.5 SAVE Graphic**

1. **Right Click** → **File** → **Save BGR**.

   OR - Select the **Save BGR Icon**.

---

- 91 -
2. The SAVE BGR File Dialog Box appears (figure A.13).

![Save BGR File Dialog Box](image)

*Figure A.13 - SAVE BGR File (Save Graphic)*

3. **Type a File name** for the graphic with the `.bgr` extension. For example type **METER.BGR**

4. **Check** the **SAVE DRW** option.

5. Select **Entire Drawing** radio button.

6. Select **OK**.

7. The Save **DRW dialog Box** appears. Accept the default name, which is the same as the BGR.

8. Select **OK**.

The **BGR** file is a compiled Graphic suitable for Display by the WebAccess Client. **You cannot edit a BGR file.** The **DRW** file is the source file. You can Edit the DRW file and generate a new BGR
file. They do not have to be the same name, but it is easier to remember if you do.

6.3.6 Download Graphic

1. Open Project Manager Window (Figure A.1). There should be another Browser window opened to it already, if you followed this step by step (refer to Section 1 to refresh your memory).

2. Select Download or GRAPH ONLY (Figure A.1). The Graph Only link results in a download of only Graphic Files from the WebAccess Project Node to the SCADA node. Graph Only does not stop the SCADA node.
7. Example B - Build a Project

Overview

This section assumes you have gone through Step 1 and Step 2.

7.1 Start Project Manager

1. Select the Project Management button on the HOME Page (bwroot.asp), Figure 2-25.
2. The Login Page appears, Figure 2-26 (bwconfig.asp)
3. Login with Default username and password

If this is a new system or you are connecting to the Live Demo, use the "Default Login". Otherwise, use your Login Name and Password.

   a. In the Login Name field type: admin
Quick Start

b. Leave **Password** field blank (i.e. no password)

c. Click the **Login Button**

"WebAccess Project(s)" list appears (bwproj.asp).

If this is a newly installed system, the Project Configuration Page appears will be empty. (figure B.1)

*Figure B.1 - Create new Project - No Current Projects*
Otherwise, a list of projects previously configured appears (Figure 2–28).

Figure 2–28 – Project List

7.2 Create a New Project

Project List Page appears (figure B.1)
1. **Scroll** to the bottom of the **Project List Page** (Figure B.1) to the section labeled Create New Project.

2. **Enter Project Name.**

   For Example: pName

3. Accept the default IP address for the project database.

   **Project IP Address** 64.232.247.175
The default IP address that appears is of the WebAccess Project Node. We recommend that you can accept this default. If there is only one Node in your system, the PC where the Project Database is stored (the Project Node) and the SCADA Node are usually the same. The WebAccess Project Node software must be installed before you can configure a project (see Installation Guide to install software on the project node).

4. Enter a **Description**.

5. Enter **Primary TCP Port**.  
   
   For Example: 0

The **Primary Port Number** is a TCP through your firewall. This applies only if you are using a firewall. See the [Appendix](#) for more information.

6. Enter **Project Timeout**.  
   
   For Example: 0

The **Project Timeout** is for Clients not using the ICMP protocol to detect a TCP/IP connection. This is the Time in increments of 50 milliseconds of inactivity before the connection is considered broken.

7. Accept default **Remote Access Code**.
It is Blank if none configured during installation of SCADA node.

This Remote Access Code is set during Installation of the SCADA node software on the SCADA node. This code prevents unauthorized users from creating new projects or new nodes on your SCADA node.

8. Press Submit Button.

9. Project Property Page appears (figure B.2)

Congratulations! You have created your first WebAccess Project.

### 7.3 Add SCADA Node

![Project Property Page](image)
1. Select Add SCADA Node from the main frame of the Project Property Page (Figure B.2).

2. **Create New Node** Page appears (Figure B.3)

![Add SCADA Node](image)

*Figure B.3 - Create New Node*

3. Enter a **Node Name** (figure B.3)

   This can be a new name that does not match the Microsoft name of the computer. This is the name that will appear in the List of nodes in Web Access. For Example: **SCADAnode1**.

4. Enter a **Node Description**.
5. Enter IP Address of the SCADA Node (Figure B.3)

This should be the IP address of the SCADA node: the PC connected to your PLC, DCS, DDC controller or other automation device. The default IP address that appears is of the WebAccess Project Node. You can accept this if you are just exploring. If there is only one Node in your system, the SCADA Node and the WebAccess Project Node are usually the same. There can be many SCADA nodes assigned to a project accessed through a single Project Node. The WebAccess SCADA node software must be installed on the SCADA node before you can download and start your project on that node (see About Addresses and the Installation Guide for more information).

That is the minimum required. The next steps are optional/

6. Enter a **Primary and Secondary TCP Port Numbers** if users will connect to SCADA node through a firewall. (See Appendix for more information on firewalls). (0 is the default ports 4592 and 14592)

7. Enter a **Node Timeout** if network connections are slow (0 = default = 15 seconds).

Leave Blank if none configured during installation of SCADA node

The Remote Access Code is set during Installation of the SCADA node software on the SCADA node. This code prevents unauthorized users from creating new projects or new nodes on your SCADA node. See Engineering Manual for more information.

9. Optionally, enter Backup SCADA Node information. This is for a redundant SCADA node to take over communications if the primary failed. SCADA node software must be installed on the backup. It must have a separate license and Hardkey.

10. Press Submit button (figure B.3).

11. The Main Project Manager Page appears (figure B.4)
7.3.1 Navigation Tree

Web Access Navigation Tree (Figure B5) is in the left frame of the Project Manager (see Figure B4) showing Project/Node, Device Type, OPC Items etc.
7.4 Add Calculation Point

1. Select the Yellow Folder to the left of the SCADA node or Select the hyperlink itself (for example, SCADA node1).

Node Properties Page

The Calculation Point List opens.
3. Select **CalcPoint** from the Calculation Point List

5. Create New Tag (Calculation) Configuration appears (figure B.7)
7.5 Add Accumulation Point

1. Select the SCADA node.

2. Select **AccPoint** from the main Frame (figure B.8).

3. **Accumulation Point List** appears.

4. Select **Add Accumulation Point**.

5. Enter **Tag Name**. For Example, type: **TIMER**

6. Enter **Description**. For Example, type: **SINE function input**

7. Enter **Source Tag Name**. For Example, type: **SPEED**

8. Enter **High Span**. For Example, type: **3600**

9. Enter **Output High Limit**. For Example, type: **3600**

10. Enter **Value Limit** (Reset Limit). For Example, type: **3599**
11. Press **Submit** Button.

Check to see that there is a Constant Point named **SPEED**. If not, go back to **STEP 2 - Project Manager** to Add Constant Point named SPEED so the Accumulation Tag and Calculation Tag will work.

**7.5.1.1 DOWNLOAD and Restart your node**

Remember to Download and Restart your SCADA node after you are done adding points in order to see your changes. This was covered earlier in Step 2 - Project Manager.

Please refer to **2.2.4 - Download to remote SCADA node** on how to Download your database changes to a SCADA node.

Please refer to **2.2.5 - Stop and Start a remote SCADA node** on how to Start and Stop a Remote SCADA Node.
8. Tips & Tricks

8.1 How to Start Internet Explorer?

FIGURE 1.1 Windows 2000 Desktop shows Internet Explorer Icons, Taskbar and Start Button.
There are three common ways to start Internet Explorer.

### 8.1.1.1 Start Internet Explorer using an Icon on Taskbar

1. Move cursor over Icon

2. Click once with the Mouse
8.1.1.2 To Start using an Icon on Desktop

1. Move cursor over Icon

2. Double Click with the Mouse

8.1.1.3 To Start using the Start Button (Short hand notation)

Start -> Programs -> Internet Explorer

The above Short hand notation is the equivalent to:

1. Move Cursor over "Start". Click once with mouse.

2. Move Cursor over "Programs".

3. Move Cursor over "Internet Explorer". Click once with mouse

8.2 Where to download Internet Explorer?

Microsoft will give you Internet Explorer 6 or 7.0 for free if you do not already have it. Go to http://www.microsoft.com/downloads/search.asp?
8.3 Address Bar missing from Internet Explorer?

If the Address Bar does not appear in your Browser, you can enable it using the following:

From the Menu Bar select with the mouse:

(IE 7.0 Users may have to press the Alt key in order to show the Menu Bar).

View-> Toolbars->Address Bar

Figure A.4 - Use Internet Explorer Menu Bar - to view Address Bar
8.4 Cannot Install or Run Client (View or Draw) with User Account

The information in this tip applies to:

- Microsoft Windows XP Home Edition
- Microsoft Windows XP Professional
- Microsoft Windows 2000 Advanced Server
- Microsoft Windows 2000 Professional
- Microsoft Windows 2000 Server

Because of the higher security in Windows 2000 and Windows XP, you will not be able to install or run the WebAccess Client (View or Draw) with a User account (also called a Restricted User in Windows 2000).

By default, Windows 2000 and XP does not let a standard user or guest account install programs or run programs that access the registry. WebAccess will work properly if you use a Power User account or an account with higher privileges.

If you are using Windows 2000 or XP, you must be a **Standard User** to install and run the WebAccess Client. A **Standard User** is a member of the **Power Users**.

Restricted Users (i.e. members of the Users Group) cannot install and cannot run the WebAccess Client. You should contact your system administrator and ask to be changed to a Standard User (i.e. A Power User). For More information see Tips & Tricks, [Determine User’s Security Privileges](#)
8.5 Security settings do not allow file download

When attempting to connect to WebAccess SCADA node using VIEW, the error message is: Your Current Security Settings Do Not Allow This File To Be Downloaded

![Security Alert]

Cause

The security setting in your browser may be set to "High".

Resolution

To change the security setting in Internet Explorer 6.0:

1. In the browser’s Tools menu, select Internet Options.

2. In the Internet Options dialog box, click the Security tab.

3. In the "Select a Web content zone..." control, click the Internet icon.
4. In the "Security level for this zone" area, move the slider to Medium.

5. Click OK.

**8.5.1 Add-Ons disabled in IE prevent Client from Starting**

VIEW shows a blank White Screen or "WebAccess Client Plug-in could not be Started" even though you have installed it.
To Check ADD-ONS in Internet Explore 7.0 Web Browser

1) If the top menu bar is not showing, press the ALT key.

2) On the top Menu bar of Internet Explorer select **Tools->Manage Add-Ons -> Settings -> Enable or Disable Add-Ons**

In the Manage ADD-Ons if **WEBBDACT** or **WEBVACT** are disabled, this is probably the problem.
3) Select **WEBDACT Control**

4) Select **Enable**

5) Select **WEBVACT Control**
6) Select **OK**

You may have to restart Internet Explorer for these to take effect. Close the IE browser (all tabs all occurrences).

---

### 8.6 Determine User's Security Privileges

1) Open the Control Panel  
   *(Click on Start->Settings->Control Panel)*.

2) **Double Click** on **Administrative Tools**.

3) **Double Click** on **Computer Management**.

4) **Click** on **Local Users and Groups**.

5) **Click** on **Users**.

6) **Double Click** on **Users**.

7) From the List, **Right Click** on **Your User Name**.

8) From the popup menu, **Click** on **Properties**.

9) From the Properties box, **Click** on the **Member Of** tab.
Figure A.5 - Windows 2000 User Security – Power User required to run WebAccess Client

If it lists **Power Users** (see figure A.5), you are a **Standard User** and can install and run WebAccess Client.

If it lists **Users** (see figure A.6), you are a **Restricted User** and cannot install and cannot run Web Access Client. Contact your system administrator and ask to be changed to a Power User.
Figure A.6 - Windows 2000 Restricted User

8.7 Locked File Detected trying to Install Client

If your receive the following Locked File error message while trying to install the Client, an Internet Explorer is probably trying to run the client.
1. Minimize the Install Shield Window.

2. Close all Internet Explorer windows.

3. Open the Install Shield Window

4. Select Retry.

---

### 8.8 Blank Screen in VIEW

#### Symptom

VIEW in a web browser shows a White screen that is blank. No error message.

#### Causes

i. **Web Browser Security too high** preventing the ActiveX control (the Plug-in) from running. Medium security is needed to allow safe browsing and the Active X control to run. — Or —

ii. **Deploy file** (*project.dpj*) not downloaded from Project Node to Client — or —

iii. **Not using Internet Explorer 6.0 or later**

iv. **Using a New Client to view an older software version of Project Node or SCADA node**
Diagnostic

Check Internet Explorer Security Settings

1) On the Menu bar of Internet Explorer select **Tools**->**Settings**

2) In the Settings Dialog Box select the **Security Tab**

3) Select **Internet** or **Local intranet** (Local intranet will allow you to maintain highest security for all other web sites, but allow WebAccess VIEW (an ActiveX control) to run inside your browser.)

4) Select **Default Level**

5) Select **Medium**

6) Select **OK**
Internet Zone – change here affect all websites you visit.
Local Intranet or Trusted Sites – changes here do not affect unknown web sites you visit.

7) If you selected **Local intranet** or **Trust Sites** – select **Sites**

8) Select **Advanced**

9) Type the IP Address of the WebAccess Project Node
10) Select Add

11) Select OK

12) Select OK

13) Select OK

Now see if you can run VIEW in your browser.

**8.8.1.1 Windows Vista**

For WebAccess software to run on Windows Vista, the User Account Control feature on Windows Vista must be disabled. The User Account Control feature on Windows Vista is considered widely to be one of the largest downfalls of Vista by many tech reporters. We think the
UAC feature is unnecessary. During WebAccess installation, User Account Control feature will be turned off.

As a result of this, IE 7 Protected Mode is also turned off. The Protected Mode of IE 7 must be off for the WebAccess Client and other important functions to work properly. If you do not agree this, please do not install WebAccess Node or Client on Windows Vista.

One option is to add the Project Node to your list of trusted sites and Disable Protected Mode in IE 7.

To Check Security Settings in Internet Explorer 7.0 Web Browser

1) On the Menu bar of Internet Explorer select Tools->Settings

1a) IE 7 users may have to press the Alt key to show the top menu bar.

2) In the Settings Dialog Box select the Security Tab

3) Select Internet, Trusted Sites or Local intranet (Local intranet will allow you to maintain Highest security for all other web sites, but allow WebAccess VIEW (an ActiveX control) to run inside you browser.) (You will need to add the project node’s address to Trusted sites if you are to use it as a trusted site)

4) Select Default Level

5) Select Medium
6) Uncheck to Disable Protected Mode (requires restarting Internet Explorer).
7) Select **OK**

**Check the Deploy file**

The deploy file (*projectname.dpj*) is downloaded by clients. The deploy file describes the IP addresses for your SCADA nodes. It is read by clients using HTTP (hyper text transfer protocol). The deploy file is on the Project Node. Possible Causes of this are:

i. Web Server not running on Project Node

ii. Web Service not installed on Project Node

iii. Improper Security on Project Node

iv. Logon Security prevents clients from reading deploy file

v. Directory or Folder security prevent WebAccess software from creating deploy file

**Try accessing the Deploy File from your current location:**

In Internet Explorer 6 (or any web browser) **enter in the address bar:**

http://ip_address of your project node/broadweb/projectname.dpj

For example, to test if Live demo deploy file is available type:

http://64.55.156.4/broadweb/LiveDemo.dpj
If you get an error message “the folder can not be accessed” then the Web Server service is not running on the project node or WebAccess is not installed.

If you get the message “Access Denied” then the security settings are set improperly on the Project Node for either the Web service or the wwwroot folders (subdirectories).

If you get the message “File not Found” then the project was not downloaded or security settings are set improperly on the Project Node for either the Web service or the wwwroot folders (subdirectories).

**WINDOWS SECURITY prevents VIEW from running**

If you are using Windows 2000 or XP, you must be a Standard User to install and run the WebAccess Client. A Standard User is a member of the Power Users.

Restricted Users (i.e. members of the Users Group) cannot install and cannot run the WebAccess Client. You should contact your system administrator and ask to be changed to a Standard User (i.e. A Power User).

**Download the Client Plug-in from the Project you are trying to connect to be sure your software version matches.**

There is a Download Plug-in Here link at the WELCOME Page. For example at the DEMO it is at:
http://64.55.156.4/broadWeb/bwroot.asp?username=admin
If you can not find the Download Link, enter:
http://64.55.156.4/broadWeb/WebAccessClientSetup.exe

Replace 64.55.156.4 with the IP address of your project Node.

8.9 How to View without the navigation tree?

1) Create a Hyperlink or edit an existing hyperlink with the following (See above question).

2) Append a question mark at end of address and add options. For Example:  http://64.55.156.4/bwviewpg.asp?proj=LIVEDEMO&node=SCADANode1

Replace 64.55.156.4 with your ipaddress.

Replace LiveDemo with your project name.

Replace SCADANode1 with your SCADA node name.

8.10 How to open WebAccess View in a new window?

1) Login to desired project, and select a node.

2) **Right Click** the Start View link in Project Manager.  *(Figure 2.4)*.

3) Select Open in New Window from the menu *(Figure A.1)*.

4) Add to Favorites.
8.11 How to connect directly to WebAccess View?

From the address bar enter:

http://address/broadweb/bwviewpg.asp?proj=projectname&node=node

For Example:

http://64.55.156.4/broadweb/bwviewpg.asp?proj=LIVEDEMO&node=SCADANode1

There are other view options, to login with username and password, go to a graphic and to hide the toolbar, caption and status bar.

From a Hyperlink:

To go directly to a SCADA node, login and go to a desired display with one click of the mouse, build a hyperlink on your project node with

<a href="/broadWeb/system/bwviewpg.asp?proj=LIVEDEMO&node=SCADANode1&user=power&pass=power&tree=0&goto=graph=1welcome.bgr&tool=1&capt=1&stat=1" target="_blank">Power User LOG IN (click here!)</a>

For example:

http://64.55.156.4/broadweb/bwviewpg.asp?proj=LIVEDEMO&node=SCADANode1&user=power&pass=power&tree=0&goto=graph=1welcome.bgr&tool=1&capt=1&stat=1
8.12 What is a Firewall and TCP Port?

If your connection to the WebAccess DRAW or VIEW fails, but connection to the Project Manager worked, then a firewall is the most likely reason.

A Firewall restricts the flow of data onto a network; it is a method of network security. Many corporations use firewalls. If your connection is through a firewall, you will need to have your network administrator open two TCP ports for you to use the DRAW or VIEW features in WebAccess. You should be able to use the Project Manager without having TCP ports opened for you. This only applies if you are connecting through the firewall. If all your WebAccess Clients and SCADA nodes are inside the firewall, you can ignore this. The TCP ports are set on the SCADA node. You can see the TCP Ports listed in the Project Manager described in Section 1. Note that 0 means the default ports numbers are used (4592 and 14592).

8.12.1.1 Live Demo TCP Ports

If you are connecting through a firewall to the LiveDemo, you will have to have your network administrator open two TCP ports for you. The demo uses:

- Primary TCP Port = 4592
- Secondary TCP Port = 14592
8.13 Disable Internet Connection Firewall in XP

1. Open Network Connections (Click Start, click Control Panel, and then double-click Network Connections.)

2. Click the Dial-up, LAN or High-Speed Internet connection that you want to protect, and then, under Network Tasks, click Change settings of this connection.

3. On the Advanced tab, under Internet Connection Firewall, select one of the following:

   - To enable Internet Connection Firewall (ICF), select the Protect my computer and network by limiting or preventing access to this computer from the Internet check box.

   - To disable Internet Connection Firewall, clear the Protect my computer and network by limiting or preventing access to this computer from the Internet check box. This disables the firewall; your computer and network are then vulnerable to intrusions.
Alternatively, use update to update your project to match the new remote access code entered during the install. This might be faster if you are the only user.

8.14 **Use WebAccess without an Internet or Intranet.**

You can install the Project Node and SCADA node software on a PC and it will function like an ordinary HMI / SCADA software. VIEW and DRAW can be started from an icon on your SCADA node’s taskbar. You will have to use a Browser to configure the WebAccess Database. You can connect locally using one of the address: `localhost` or `127.0.0.1`
Please refer to the Installation Manual on how to install the SCADA node Software.

### 8.15 Determine Windows version

1. On the taskbar, click **Start**, and then click **Run**.

2. In the **Run** dialog box, type **Winver** and press the **Enter** key.

3. The resulting dialog box will indicate the version of Microsoft Windows® you are using.

4. After recording the version you are running, click **OK** to close the dialog box.

### 8.16 How to PING and test your TCP/IP connection?

PING is a method of testing communications from your computer to the WebAccess Project or SCADA node. It is built into Microsoft Operating Systems and just sends a short message to the target machine and hopefully gets a reply back if the TCP/IP communications are working.

1. You can PING from the Command Prompt.

   **Start** → **Programs** → **Accessories** → **Command Prompt**

2. Then type: **PING ipaddress**
To ping the Live Demo’s IP address, type: **PING 64.55.156.4**

You can also ping a registered URL or valid TCP/IP host name (i.e. computer name). To ping a URL, type: **PING www.advantech.com**